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ABSTRAK 
 

Tujuan dari penelitian yaitu membuat suatu suatu Prototipe Monitoring Pendeteksi Asap Rokok dan Kebakaran 

Menggunakan Sensor MQ-2 Berbasis Mikrokontroler Arduino Uno.  

 

Dalam membangun alat ini menggunakan metode Prototyping. Pada metode ini terdapat 3(tiga) proses untuk 

mengembangkan suatu Alat Monitoring. Ketiga tahapan diantaranya pengumpulan kebutuhan, perancangan, dan evaluasi 

Prototype. Dengan design sistem menggunakan Flowchart.  Pengujian dilakukan menggunakan White Box dan Black Box. 

Dengan membangun sebuah kotak simulasi berisi dua buah ruang, yaitu ruang kelas, dan ruang BAAK. Dan terdiri dari 

beberapa komponen, yaitu : Arduino Uno, Sensor MQ-2, Module ISD1820, Module SIM900A dan Breadboard.. 
 

 

Kata Kunci: Prototipe, Monitoring, Pendeteksi, Asap Rokok, Kebakaran, sensor, Mikrokontroler, Arduino Uno. 

1. PENDAHULUAN [Times New Roman 10, rata 

kiri] 

Merokok merupakan hal yang populer di kalangan 

mahasiswa di setiap kampus. Tentunya asap rokok 

sangat mengganggu lingkungan di sekitarnya bagi orang 

yang tidak merokok. Menurut para ahli asap rokok lebih 

berbahaya bila dihirup oleh orang yang tidak merokok. 

Rokok akan menghasilkan asap rokok sebagai hasil dari 

tembakau yang dibakar sehingga dapat mengganggu 

orang yang tidak merokok di lingkungan kampus hingga 

kedalam ruang kelas yang sudah pasti terdapat larangan 

untuk tidak merokok.  

Di perlukankan sebuah sistem yang dapat mendeteksi 

asap rokok pada ruang kampus dengan menggunakan 

sensor asap rokok. Selain bahaya akan asap rokok, pihak 

kampus juga sering di khawatirkan oleh bahaya 

kebakaran yang sewaktu-waktu mungkin terjadi. 

Ruangan–ruangan yang sangat di khawatirkan akan 

bahaya kebakaran seperti ruang akademik dan ruang di 

gedung rektorat lainnya yang menyimpan berbagai 

macam berkas penting untuk keperluan kampus. 

Pada penulisan ini telah di rancang suatu sistem yang 

mendeteksi adanya asap rokok dan bahaya kebakaran. 

Alat yang di rancang untuk mendeteksi adanya asap 

rokok dan kebakaran menggunakan sensor MQ-2. Sensor 

yang digunakan dikontrol dengan menggunakan 

mikrokontroller Arduino Uno sebagai otak dari sistem 

yang dirancang. Sistem yang di rancang tidak hanya 

mendeteksi adanya asap rokok dan kebakaran, tetapi juga 

memberikan output berupa alarm pada deteksi asap 

rokok sebagai peringatan bagi mahasiswa yang merokok 

di ruang kelas. Selain itu, sistem ini juga akan 

memberikan pesan kepada security yang bertugas 

melalui sms gateway untuk segera menertibkan 

mahasiswa yang melanggar larangan merokok didalam 

ruang kelas atau segera bertindak jika pesan yang didapat 

merupakan pesan peringatan kebakaran yang terjadi pada 

salah satu ruang di gedung rektorat kampus. 

2. RUANG LINGKUP PENELITIAN 

Permasalahan difokuskan pada: 

1. Prototipe pendeteksi asap rokok dan kebakaran 

menggunakan Mikrokontroler Arduino uno. 

2. Sensor yang di gunakan adalah sensor MQ-2.  

3. Indikator peringatan yang menandakan keberadaan 

asap rokok di ruang kejadian menggunakan Module 

ISD1820 

4. Pesan peringatan adanya pelanggaran asap rokok atau 

bahaya kebakaran menggunakan sistem sms dengan 

Module SIM900A GSM/GPRS Shield. 

5. Pesan sms dapat dikirim lebih dari satu nomor secara 

bergantian 

6. Alarm Peringatan bahaya kebakaran menggunakan 

buzzer 

 

3. BAHAN DAN METODE [Huruf Kapital]  

Main heading ditulis dengan huruf kapital semua. 

Penomeran heading dengan sistem arabic dengan sub-

heading maksimal 3 tingkat. 

 

3.1 Penjelasan Bahan 

3.1.1 Arduino Uno 

mailto:acep.noor@gmail.com


 

Menurut Abdul Kadir (2015), Arduino Uno 

berukuran sebesar kartu kredit. Walaupun berukuran 

kecil seperti itu, papan tersebut mengandung 

mikrokontroler dan sejumlah input/output (I/O) yang 

memudahkan pemakai untuk menciptakan berbagai 

proyek elektronika yang dikhususkan untuk menangani 

tujuan tertentu. Bagian-bagian di Arduino Uno yang 

perlu diketahui. 

 
Gambar 1.  Bagian-bagian Arudino Uno 

 

Penjelasan bagian masing-masing seperti berikut. 

1.Port USB digunakan untuk menghubungkan 

Arduino Uno dengan komputer, melalui sepasang kabel 

USB. 

2.Penghubung catu daya eksternal digunakan 

untuk memasok sumber daya listrik untuk Arduino Uno 

ketika tidak dihubungkan ke komputer melalui kabel 

USB, pasokkan daya listrik diberi oleh komputer. 

3.Pin digital mempunyai label 0 sampai dengan 

13. Disebut pin digital karena mempunyai isyarat digital, 

yakni berupa 0 atau 1. Dalam praktik, nilai 0 dinyatakan 

dengan tegangan 0 v dan nilai 1 dinyatakan dengan 

tegangan 5v. 

4.Pin analog berarti bahwa pin – pin ini 

mempunyai nilai yang bersifat analog (nilai yang 

berkesinambungan). Dalam program, nilai setiap pin 

analog yang berlaku sebagai masukkan (hasil dari 

sensor) berkisar antara 0 sampai dengan 1023. 

5.Mikrokontroler yang digunakan di Arduino Uno 

adalah Atmega328 

6.Ada dua pin yang dapat digunakan untuk 

memasok catu daya kekomponen elektronis yang 

digunakan dalam menangani proyek, misalnya sensor 

gas, sensor jarak, dan relai. Tegangan yang tersedia 

adalah 3,3V dan 5V. Komponen-komponen elektronis 

yang diberi tegangan oleh Arduino Uno adalah yang 

memerlukan arus kecil. Sebagai contoh, motor DC yang 

menarik arus lebih dari 500mA harus menggunakan catu 

daya tersendiri. 

3.1.2  Modul ISD1820 

Menurut Abdul Kadir (2015), Modul perekam 

suara ISD1820 dapat digunakan untuk kepentingan 

merekam suara dan kemudian memainkan kembali 

rekaman suara. Namun, suara yang dapat direkam 

terbatas hanya sekitar 10 detik. Modul telah dilengkapi 

dengan speaker 0,5 Watt 8 ohm. 

 
Gambar 2. Module ISD1820 

 

Pin SP1 dihubungkan ke speaker. Adapun enam pin 

dibagian kiri mempunyai fungsi sebagai berikut : 

1. VCC  : Tegangan 3V-5V DC 

2. GND  : Ground 

3. FT  : Feed Through  

4. P-L  : Jika Bernilai HIGH, Suuara akan   

  dimainkan sampai akhir 

5. P-E  : Suara hanya diperdengarkan ketika  

  pin bernilai HIGH 

6. REC : Suara di rekam ketika pin bernilai  

  HIGH saja   

Modul perekam suara ISD1820 dapat diuji tanpa 

menggunakan Arduino. Caranya, hubungkan pin VCC ke 

sumber tegangan +5V dan pin GND ke ground. 

Selanjutnya tekanlah tombol REC dan jangan dilepaskan. 

Saat itulah anda bisa berbicara didepan mikrofon. Jika 

sudah selesai, lepaskan penekanan pada tombol REC. 

Untuk memainkan suara, tekan tombol PLAYE ( tanpa 

perlu menekan terus). Suara akan dimainkan sampai 

akhir suara dijumpai. Kalau hanya ingin memainkan 

suara sesaat (hanya ketika tombol ditekan), tekanlah 

tombol PLAYL. 

3.1.3 Sensor MQ-2 

MQ-2 adalah komponen elektronika untuk 

mendeteksi kadar gas hidrokarbon seperti iso butana 

(C4H10 / isobutane), propana (C3H8 / propane), metana 

(CH4 / methane), etanol (ethanol alcohol, CH3CH2OH), 

hidrogen (H2 / hydrogen), asap (smoke), dan LPG 

(liquid petroleum gas). Gas sensor ini dapat digunakan 

untuk mendeteksi kebocoran gas di rumah / pabrik, 

misalnya untuk membuat rangkaian elektronika 

pendeteksi kebocoran elpiji. MQ-2 berfungsi untuk 

mendeteksi keberadaan asap rokok di udara. Sensor akan 

mendeteksi keberadaan gas yang terkandung dalam asap 

rokok seperti asap maka resistansi elektrik sensor akan 

turun. Memanfaatkan prinsip kerja dari sensor MQ-2 ini, 

kandungan gas asap tersebut dapat terdeteksi. Sensor 

MQ-2 ini memiliki 6 buah masukan yang terdiri dari tiga 

buah supply power (VCC) sebasar +5 volt untuk 

mengaktifkan heater dan sensor, VSS (Ground), dan pin 

keluaran dari sensor tersebut. Pin keluaran dari sensor 

dihubungkan dengan ADC 0832 pada chanel 2 sebagai 

masukan. Tampilan sensor asap rokok MQ-2 seperti 

pada gambar di bawah berikut. 



 

 
Gambar 3. Sensor MQ-2 

Sumber : Kadir Abdul, 2014. From Zero to a PRO 

Arduino. 

Nilai RL sesuai dengan datasheet yaitu 10 KΩ. 

Tingkat sensitivitas sensor MQ-2 bervariasi untuk 

masing-masing tipe gas hidrokarbon yang dapat 

dideteksi sesuai tabel berikut ini:  

1. LPG & propane : 200 - 5000 ppm  

2. i-butana : 300 - 5.000 ppm  

3. metana : 5.000 - 20.000 ppm (untuk sensor yang 

lebih sensitif terhadap methane, gunakan gas sensor 

MQ-4)  

4. hydrogen : 300 - 5.000 ppm 

5. etanol / alkohol: 100 - 2.000 ppm (bila diperlukan 

sensor yang spesifik untuk alkohol, gunakan MQ-3 

Alcohol Detector Sensor)  

Keluaran sensor ini berupa resistansi analog yang 

dengan mudah dapat dikonversi menjadi tegangan 

dengan menambahkan satu resistor biasa (bisa juga 

menggunakan potensiometer sehingga ambang batas 

sensitivitas deteksi dapat disetel sesuai kebutuhan). 

Dengan mengkonversi impedansi ini menjadi tegangan, 

hasil bacaan sensor dapat dibaca oleh pin ADC (analog 

to digital converter) pada microcontroller. Nilai resistansi 

dari MQ-2 adalah perbedaan untuk berbagai jenis dan 

berbagai gas konsentrasi. Sensor ini, penyesuaian 

sensitivitas sangat diperlukan dengan mengkalibrasi 

detektor untuk 1000ppm liquified petroleum gas (LPG), 

atau konsentrasi 1000ppm iso-butana (i-C4H10) nilai 

udara dan penggunaan Resistensi beban yang (RL) 

sekitar 20 KΩ (5KΩ dengan 47 KΩ). Ketika akurat 

mengukur, titik alarm yang tepat untuk detektor gas 

harus ditentukan setelah mempertimbangkan pengaruh 

suhu dan kelembaban. 

3.1.4 Module SIM900A GSM/GPRS Shield 

SIM900A adalah slah satu produk GSM/GPRS 

serial modem dari SIMCOM yang dapat gunakan 

bersama mikrokontroller Aarduino baik untuk fitur sms, 

telepon atau data GPRS.berikut fiture dari module chip 

SIM900A : 

1. Quad-Band 850/900/1800/1900 MHz : Bisa 

dihunakan pada jaringan GSM diberbagai negara 

2. GPRS Multi-Slot Class 10/8 

3. GPRS Mobile Station Class B 

4. Compliant to GSM Phase 2/2+ 

5. Class 4 (2 W (AT) 850/900 MHz) 

6. Class 1 (1 W (AT) 1800/1900 MHz) 

7. Perintah menggunakan AT Command-Standard 

Commands:GSM 07.07 & 07.05 | Enhanced 

Commands: SIMCOM AT Commands. 

8. Layanan pesan singkat (SMS) 

9. Embedded TCP/UPD Stack: dapat upload data ke 

web server 

10. Support RTC 

11. Pemilihan port serial (3.3V dan 5V Level) 

12. Terdapat jack speaker dan handphone (Type breakout 

tertentu) 

13. Konsumsi daya rendah : 1.5mA (sleep mode) 

14. Bekerja pada temperatur : -40C to +85 C 

 
Gambar 4. Module SIM900A GSM/GPRS Shield 

3.1.5 Arduino Development Environment 

Arduino Development Environment terdiri dari 

editor teks untuk menulis kode, sebuah area pesan, 

sebuah konsol, sebuah toolbar dengan tomol-tombol 

untuk fungsi yang umum dan beberapa menu. Arduino 

Development Environment terhubung ke arduino board 

untuk meng-upload program dan juga untuk 

berkomunikasi dengan arduino board.  

Perangkat lunak yang ditulis menggunakan Arduino 

Development Environment disebut sketch. Sketch ditulis 

pada editor teks. Sketch disimpan dengan file berekstensi 

.ino. Area pesan memberikan memberikan informasi dan 

pesan error ketika kita menyimpan atau membuka 

sketch. Konsol menampilkan output teks dari Arduino 

Development Environment dan juga menampilkan pesan 

error ketika mengkompile sketch. Pada sudut kanan 

bawah dari jendela Arduino Development Environment 

menunjukkan jenis board dan port serial yang sedang 

digunakan. Tombol toolbar digunakan utuk mengecek 

dan mengupload sketch, membuat, membuka atau 

menyimpan sketch, dan menampilkan serial monitor. 

  
Gambar 5.  Arduino Development Environment 

 

Dalam lingkungan arduino digunakan sebuah 

konsep yang disebut sketchbook, yaitu tempat standar 

untuk menumpan program (sketch). Sketch  yang ada 

pada sketchbook dapat dibuka dari menu File > 

Sketchbook atau dari tombol open pada toolbar. Ketika 



 

pertama kali menjalankan arduino development 

environment, sebuah direktori akan dibuat secara 

otomatis untuk tempat penyimpanan sketchbook. Dapat 

melihat atau mengganti lokasi dari direktori tersebut dari 

menu File > Preferences.  

Serial monitor menampilkan data serial yang 

sedang dikirim dari arduino board. Untuk mengirim data 

ke board, masukkan teks dan klik tombol send atau tekan 

enter pada keyboard.   

Sebelum meng-upload program, perlu mensetting 

jenis board dan port serial yang sedang kita gunakan 

melalui menu Tools > Board dan Tools > Serial Port. 

Pemilihan board berguna untuk mengeset parameter 

(contohnya: kecepatan mikrokontroler) yang digunakan 

ketika meng-compile dan mengupload sketch.  

Setelah memilih board dan port serial yang tepat, 

tekan tombol upload pada toolbar atau pilih menu File > 

Upload. Arduino board akan me-reset secara otomatis 

dan proses upload akan dimulai. Pada kebanyakan board, 

LED RX dan TX akan berkedip ketika program sedang 

di-upload. Arduino development environment akan 

menampilkan pesan ketika proses upload telah selesai, 

atau menampilkan pesan error. Ketika sedang meng-

upload program, arduino bootloader sedang digunakan, 

Arduino bootloader adalah sebuah program kecil yang 

telah ditanamkan pada mikrokontroler yang berada pada 

arduino board. Bootloader ini mengijinkan meng-upload 

program tanpa menggunakan perangkat keras tambahan. 

3.2 Prototyping Model (Model Prototipe) 

Pendekatan prototyping metode digunakan jika 

pemakai hanya mendefiniskan objektif umum dari 

perangkat lunak tanpa melihat kebutuhan input, 

pemrosesan dan outputnya. 

 
Gambar 6. Diagram Prototype 

 

Dari Gambar 2.9 Pendekatan Prototyping melewati 

tiga proses, yaitu pengumpulan kebutuhan, perancangan, 

dan evaluasi Prototype. Proses–proses tersebut dapat di 

jelaskan sebagai berikut: 

1. Pengumpulan kebutuhan : developer dan klien 

bertemu dan menentukan tujuan umum, 

kebutuhan yang diketahui dan gambaran 

bagian-bagian yang akan dibutuhkan 

berikutnya; 

2. Perancangan: perancangan dilakukan cepat dan 

rancangan mewakili semua aspek hardware 

yang diketahui, dan rancangan ini menjadi dasar 

pembuatan prototype; 

3. Evaluasi Prototype : klien mengevaluasi 

prototype yang dibuat dan digunakan untuk 

memperjelas kebutuhan hardware. 

Dari penjelasan tersebut terdapat kelebihan dan 

kekurangan prototype : 

Kelebihan prototype :  

1. Adanya komunikasi baik antara pengembang 

dan pelanggan 

2. Pengembang dapat bekerja lebih baik dalam 

menentukan kebutuhan pelanggan 

3. Lebih menghemat waktu dalam pengembangan 

system 

4. Penerapannya menjadi lebih mudah karena 

pelanggan mengetahui apa yang di harapkannya 

Kekurangan prototype : 

1. Resiko tinggi, untuk masalah – masalah yang 

tidak terstruktur dengan baik, ada perubahan 

besar dari waktu ke waktu dan adanya 

persyaratan data yang tidak menentu. 

2. Prototyping dapat mengurangi kreatifitas 

perancang. 

3. Developer biasanya melakukan kompromi 

dalam beberapa hal karena harus  membuat 

prototype dalam waktu singkat. Mungkin 

system operasi yang tidak sesuai, bahasa 

pemrograman yang berbeda, atau algoritma 

yang lebih sederhana. 

 

4. RANCANGAN SISTEM/APLIKASI 

4.1 Desain Blok Diagram 

 
Gambar 7.  Desain Blok Diagram 

Untuk membuat sebuah pendeteksi asap rokok dan 

kebakaran, pertama-tama yaitu memasang sensor MQ-2 

pada ruang yang akan di monitoring. Kemudian menguji 

sensor tersebut dari kepekatan asap rokok atau asap 

kebakaran yang ada di dalam ruangan tersebut. Setelah 

sensor membaca kepekatan asap barulah akan di proses 

kesistem minimum mikrokontroler arduino. 

Kemudian sistem minimum mikrokontroler tersebut 

akan memproses hasil dari sensor tersebut berdasarkan 

tingkat kepekatan asap yang diterima dari sensor. Setelah 

hasil dari pembacaan sensor apakah kadar kepekatan 

asap melebihi kadar yang sudah ditentukan maka sistem 

minimum mikrokontroler akan memerintahkan modul 

ISD1820 untuk memutar hasil rekaman terus menerus 

hingga kadar kepekatan asap turun dari batas kepekatan 

yang ditentukan begitu pula dengan Buzzer. Dan juga 

memerintahkan modul GSM SIM900A untuk 

mengirimkan pesan sms ke nomor handphone yang telah 

ditentukan sebelumnya. 

4.2 Skema Alat Monitoring Asap Rokok dan 

Kebakaran 



 

 
Gambar 8 Skema Alat Monitoring Asap Rokok 

dan Kebakaran 

 

Pada gambar 4.1 adalah skema alat monitoring asap 

rokok dan kebakaran berbasis arduino uno. Pada kabel 

berwarna merah dan biru merupakan input daya yang di 

hubungkan dengan perangkat sensor MQ-2, kabel 

berwarna merah dan cokelat sebagai input daya yang 

dihubungkan dengan perangkat modul perekam suara 

ISD1820 kemudian kabel berwarna hitam dan merah 

merupakan input daya yang dihubungkan dengan modul 

SIM900A dan kabel berwarna hitam merupakan input 

daya yang dihubungkan dengan Buzzer. 

4.3 Flowchart Program 

Flowchart merupakan gambar atau bagan yang 

memperlihatkan urutan dan hubungan antar proses 

beserta instruksinya. Gambaran ini dinyatakan dengan 

simbol. Dengan demikian setiap simbol menggambarkan 

proses tertentu. Sedangkan hubungan antar proses 

digambarkan dengan garis penghubung. 

Flowchart ini merupakan langkah awal pembuatan 

program Dengan adanya flowchart urutan poses kegiatan 

menjadi lebih jelas. Setelah flowchart selesai disusun, 

selanjutnya pemrogram (programmer) 

menerjemahkannya ke bentuk program dengan bahasa 

pemrograman. 

 
Gambar 9. Flowchart Program Asap Rokok 

 

 

 
Gambar 10. Flowchart Program Asap Kebakaran 

 

Pada alat monitoring pendeteksi asap rokok dan 

kebakaran pertama kali ialah proses membaca sensor 

asap baik asap rokok pada ruang kelas maupun asap 

kebakaran pada ruang di gedung rektorat, modul 

perekam, buzzer dan juga modul SIM. Dari sensor 

membaca tingkat kadar asap pada ruangan. Kemudian 

dari hasil pembacaan analog sensor nantinya akan 

diproses oleh mikrokontroler apabila Asap > 100ppm 

maka akan mengaktifkan modul perekam dan modul 

SIM apabila yang terdeteksi berdasarkan objek pada 

ruang kelas dan akan mengaktifkan modul SIM dan 

Buzzer apabila yang terdeteksi berdasarkan objek pada 

ruang BAAK di gedung rektorat. 

 

5. IMPLEMENTASI 

Perangkat keras yang di gunakan pada alat 

monitoring pendeteksi asap rokok dan kebakaran  ini 

adalah sensor MQ-2, Arduino Uno, Modul GSM/GPRS 

SIM900A, Modul Perekam suara ISD1820. Untuk 

kerangka simulasi ruang pendeteksi asap rokok dan 

kebakaran ini adalah kayu yang telah dimodifikasi 

menjadi 2 buah ruang simulasi asap rokok dan 

kebakaran. Dapat dilihat pada gambar berikut :  

  
Gambar 11.  Desain Monitoring Pendeteksi Asap 

Rokok dan Kebakaran 



 

  
Gambar 12.  Komponen Alat Monitoring Pendeteksi 

Asap Rokok dan Kebakaran 

 

Pada gambar diatas dapat dilihat komponen-komponen 

yang terdapat pada alat Monitoring Pendeteksi Asap 

Rokok dan Kebakaran ini 

 

6. KESIMPULAN 

1. Untuk membuat alat monitoring pendeteksi asap 

rokok dan kebakaran ini dibutuhkan lima 

komponen utama yaitu 2 sensor MQ-2 sebagai 

sensor pendeteksi masukan pada dua ruangan,  

mikrokontroler Arduino, Modul ISD1820 sebagai 

perekam dan pemutar suara peringatan, serta Modul 

GSM SIM900A sebagai pengirim pesan sms. 

2. Berdasarkan hasil dari evaluasi yang telah 

dilakukan dari tahap pertama hingga tahap ketiga 

dapat disimpulkan bahwa alat monitoring 

pendeteksi asap rokok dan kebakaran dapat 

mengirim pesan dan menyalakan suara peringatan 

sesuai dengan masukkan dari sensor pendeteksi 

asap dan sesuai dengan kondisi yang diterima pada 

sensor tersebut. 

3. Alat monitoring pendeteksi asap rokok dan 

kebakaran yang dibuat memiliki 2 macam kondisi 

yaitu kadar asap diatas 100ppm dan kadar asap 

dibawah 100ppm. 

 

7. SARAN 

1. Dikembangkan lebih lanjut agar alat monitoring 

pendeteksi asap rokok dan kebakaran ini dapat 

dimanfaatkan bagi kampus ataupun masyarakat. 

2. Mengimplementasikan prototipe alat monitoring 

pendeteksi asap rokok dan kebakaran dalam bentuk 

aslinya atau nyata. 

3. Untuk pengembang selanjutnya dapat membuat alat 

monitoring asap rokok dan kebakaran dengan 

prototipe yang berbeda dan alat yang berbeda, 

seperti sensor asap yang lebih akurat, serta modul 

GSM yang lebih canggih lagi. 

4. Untuk penelitian lebih lanjut di harapkan dapat 

mengembangkan alat ini dengan membuat 

pembersihan sirkulasi udara pada ruang deteksi 

asap rokok secara otomatis contohnya dengan cara 

penghidupan xhaust secara otomatis dan lain 

sebagainya. 
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